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Chapter 223

Group-Sequential
Superiority by a Margin
Tests for the Ratio of Two
Proportions (Simulation)

This procedure uses simulation for the calculation of the boundaries as well as for calculation of power (and
sample size). Futility boundaries are limited. A variety of test statistics are available.

Introduction

This procedure can be used to determine power, sample size and/or boundaries for group sequential superiority by a
margin tests comparing the ratio of proportions from two groups. These tests are sometimes referred to as non-zero
(or non-unity, for ratios and odds ratios) null tests. The tests that can be simulated in this procedure are the common
two-sample Z-test with or without pooled standard error and with or without continuity correction, the T-test, and
three score tests. Significance and futility boundaries can be produced. The spacing of the looks can be equal or
custom specified. Boundaries can be computed based on popular alpha- and beta-spending functions (O’Brien-
Fleming, Pocock, Hwang-Shih-DeCani Gamma family, linear) or custom spending functions. Boundaries can also
be input directly to verify alpha- and/or beta-spending properties. Futility boundaries can be binding or non-binding.
Maximum and average (expected) sample sizes are reported as well as the alpha and/or beta spent and incremental
power at each look. Corresponding P-Value boundaries are given for each boundary statistic. Plots of boundaries are
also produced.

Technical Details

This section outlines many of the technical details of the techniques used in this procedure including the simulation
summary, the test statistic details, and the use of spending functions.

An excellent text for the background and details of many group-sequential methods is Jennison and Turnbull (2000).
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Simulation Procedure

In this procedure, a large number of simulations are used to calculate boundaries and power using the following
steps

1. Based on the specified proportions, random samples of size N1 and N2 are generated under the null
distribution and under the alternative distribution. These are simulated samples as though the final look is
reached.

2. For each sample, test statistics for each look are produced. For example, if N1 and N2 are 100 and there are
5 equally spaced looks, test statistics are generated from the random samples at N1 = N2 =20, N1=N2=
40, N1=N2 =60, N1=N2 =80, and N1 = N2 =100 for both null and alternative samples.

3. Togenerate the first significance boundary, the null distribution statistics of the first look (e.g., at N1 = N2 =
20) are ordered and the percent of alpha to be spent at the first look is determined (using either the alpha-
spending function or the input value). The statistic for which the percent of statistics above (or below, as the
case may be) that value is equal to the percent of alpha to be spent at the first look is the boundary statistic.
Itis seen here how important a large number of simulations is to the precision of the boundary estimates.

4. All null distribution samples that are outside the first significance boundary at the first look are removed
from consideration for the second look. If binding futility boundaries are also being computed, all null
distribution samples with statistics that are outside the first futility boundary are also removed from
consideration for the second look. If non-binding futility boundaries are being computed, null distribution
samples with statistics outside the first futility boundary are not removed.

5. Togenerate the second significance boundary, the remaining null distribution statistics of the second look
(e.g., at N1 = N2 = 40) are ordered and the percent of alpha to be spent at the second look is determined
(again, using either the alpha-spending function or the input value). The percent of alpha to be spent at the
second look is multiplied by the total number of simulations to determine the number of the statistic that is
to be the second boundary statistic. The statistic for which that number of statistics is above it (or below, as
the case may be) is the second boundary statistic. For example, suppose there are initially 1000 simulated
samples, with 10 removed at the first look (from, say, alpha spent at Look 1 equal to 0.01), leaving 990
samples considered for the second look. Suppose further that the alpha to be spent at the second look is 0.02.
This is multiplied by 1000 to give 20. The 990 still-considered statistics are ordered and the 970t (20 in
from 990) statistic is the second boundary.

6. All null distribution samples that are outside the second significance boundary and the second futility
boundary, if binding, at the second look are removed from consideration for the third look (e.g., leaving 970
statistics computed at N1 = N2 = 60 to be considered at the third look). Steps 4 and 5 are repeated until the
final look is reached.

Futility boundaries are computed in a similar manner using the desired beta-spending function or custom beta-
spending values and the alternative hypothesis simulated statistics at each look. For both binding and non-
binding futility boundaries, samples for which alternative hypothesis statistics are outside either the significance
or futility boundaries of the previous look are excluded from current and future looks.

Because the final futility and significance boundaries are required to be the same, futility boundaries are
computed beginning at a small value of beta (e.g., 0.0001) and incrementing beta by that amount until the futility
and significance boundaries meet.

When boundaries are entered directly, this procedure uses the null hypothesis and alternative hypothesis
simulations to determine the number of test statistics that are outside the boundaries at each look. The
cumulative proportion of alternative hypothesis statistics that are outside the significance boundaries is the
overall power of the study.
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Small Sample Considerations

When the sample size is small, say 200 or fewer per group, the discrete nature of the number of possible differences
in proportions in the sampling distribution comes into play. This has led to a large number of proposed tests for
comparing two proportions (or testing the 2 by 2 table of counts). For example, Upton (1982) considers twenty-two
alternative tests for comparing two proportions. Sweeping statements about the power of one test over another are
impossible to make, because the size of the Type | error depends upon the proportions used. At some proportions,
some tests are overly conservative while others are not, while at other proportions the reverse may be true.

This simulation procedure, however, is based primarily on the ordering of the sample statistics in the simulation. The
boundaries are determined by the spending function alphas. Thus, if a test used happens to be conservative in the
single-look traditional sense, the boundaries chosen in the simulation results of this procedure will generally remove
the conservative nature of the test. This makes comparisons to the one-look case surprising in many cases.

Definitions

Suppose you have two populations from which dichotomous (binary) responses will be recorded. The probability
(or risk) of obtaining the event of interest in population 1 (the treatment group) is P, and in population 2 (the
control group) is P,. The corresponding failure proportions are given by g, =1-p, and g, =1-p,.

The assumption is made that the responses from each group follow a binomial distribution. This means that the
event probability, p;, is the same for all subjects within the group and that the response from one subject is

independent of that of any other subject.

Random samples of m and n individuals are obtained from these two populations. The data from these samples
can be displayed in a 2-by-2 contingency table as follows

Group Success Failure Total
Treatment a c m
Control b d

Total S f N

The following alternative notation is also used.

Group Success Failure Total
Treatment X1 X, n,
Control X5 Xy, n,
Total m, m, N

The binomial proportions P, and P, are estimated from these data using the formulae

Looa Xy . b X,

p=—=—"and p,=—=
m n n n,
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Comparing Two Proportions

Let p,, represent the group 1 proportion tested by the null hypothesis, H,. The power of a test is computed at a
specific value of the proportion which we will call p,,. Let & represent the smallest difference (margin of
equivalence) between the two proportions that still results in the conclusion that the new treatment is not inferior
to the current treatment. For a superiority test, & > 0. The set of statistical hypotheses that are tested is
Ho:Po— P, <3S versus Hi:p,—p,>3d
which can be rearranged to give
Ho:Po < P, +J versus Hiip > p,+J

There are multiple methods of specifying the margin of superiority. The most direct is to simply give values for
p, and p,,. However, it is often more meaningful to give p, and then specify p,, implicitly by specifying the

difference, ratio, or odds ratio. Mathematically, assuming higher proportions are better, the definitions of these
parameterizations are

Parameter  Computation Hypotheses

Difference 0=Po— D0, HoiPo— P, < VS.Hiipoy— P, >3, 6,<0
Ratio ¢= P! P, Hop/ p,<dyvs.H:p/p,>d, ¢<1

Odds Ratio w =0dds, , / Odds, Hy:0,,/0, <y, versusH;:0,,/0,>y,, w,<1
Ratio

The ratio, = p,, / P,, gives the relative change in the probability of the response. Testing superiority uses the
formulation

Ho: Pio/ P, < @ versus Hiipo/ p, > ¢,
when higher proportions are better.

The following example is used to convey the concept of superiority as defined by the ratio. Suppose that 60% of
patients (p2 = 0.60) respond to the current treatment method. If a new treatment increases the response rate by

no less than 10% (¢, =1.10), it will be considered non-inferior to the standard treatment. Substituting these
figures into the statistical hypotheses gives

H,:¢ <110 versus H, : ¢ >1.10

In this example, when the null hypothesis is rejected, the concluded alternative is that the response rate is at least
66%. That is, the conclusion of superiority is that the new treatment’s response rate is no worse than 10% more
than that of the standard treatment.
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Test Statistics

This section describes the test statistics that are available in this procedure.

Miettinen and Nurminen’s Likelihood Score Test

Miettinen and Nurminen (1985) proposed a test statistic for testing whether the ratio is equal to a specified value
@, . The regular MLE’s, P, and f,, are used in the numerator of the score statistic while MLE’s P, and P,,

constrained so that P,/ P, = ¢, , are used in the denominator. A correction factor of N/(N-1) is applied to make

the variance estimate less biased. The significance level of the test statistic is based on the asymptotic normality
of the score statistic.

The formula for computing the test statistic is

ﬁllﬁz_%

Zunr = — —
(plq1+ : szz]( NJ
n ~ n, JAN-

where
p, = p2¢o
5 - —~B-+/B*-4AC
2 2A
A= Ng,

B= _[n1¢o + X, +N, + X21¢o]

C=m,

Farrington and Manning’s Likelihood Score Test

Farrington and Manning (1990) proposed a test statistic for testing whether the ratio is equal to a specified value
@, . Theregular MLE’s, P, and f,, are used in the numerator of the score statistic while MLE’s P, and P,,

constrained so that ﬁl / ﬁz = ¢, are used in the denominator. A correction factor of N/(N-1) is applied to

increase the variance estimate. The significance level of the test statistic is based on the asymptotic normality of
the score statistic.

The formula for computing the test statistic is

_ f)1/r)2_¢0

ZFMR - - —
(plql g pzqzj
n '’ n,

where the estimates P, and P, are computed as in the corresponding test of Miettinen and Nurminen (1985)
given above.
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Gart and Nam’s Likelihood Score Test

Gart and Nam (1988), page 329, proposed a modification to the Farrington and Manning (1988) ratio test that
corrects for skewness. Let ZFMR(¢) stand for the Farrington and Manning ratio test statistic described above. The

skewness corrected test statistic, Z,g, IS the appropriate solution to the quadratic equation

(_ a)ZéNR + (_ 1)ZGNR + (ZFMR(¢) + 65) -0

where
7= 1 (51(51 - 51) _ az(az - Ez)j
663/2 nl2512 n;—ﬁzz
o6, &
np, NP,

Spending Functions

Spending functions can be used in this procedure to specify the proportion of alpha or beta that is spent at each
look without having to specify the proportion directly.

Spending functions have the characteristics that they are increasing and that
a(0)=0
a(l) =qa

The last characteristic guarantees a fixed « level when the trial is complete. This methodology is very flexible
since neither the times nor the number of analyses must be specified in advance. Only the functional form of

a(7) must be specified.

PASS provides several popular spending functions plus the ability to enter and analyze your own percents of
alpha or beta spent. These are calculated as follows (beta may be substituted for alpha for beta-spending
functions):
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8. User Supplied Percents

A custom set of percents of alpha to be spent at each look may be input directly.

NCSS.com

The O'Brien-Fleming Analog spends very little alpha or beta at the beginning and much more at the final looks.
The Pocock Analog and (Alpha or Beta)(Time) spending functions spend alpha or beta more evenly across the
looks. The Hwang-Shih-DeCani (C) (gamma family) spending functions and (Alpha or Beta)(Time”C) spending
functions are flexible spending functions that can be used to spend more alpha or beta early or late or evenly,
depending on the choice of C.
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Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design, Looks &
Boundaries, and Options tabs. For more information about the options of other tabs, go to the Procedure Window
chapter.

Design Tab

The Design tab contains most of the parameters and options for the general setup of the procedure.

Solve For
Solve For
Solve for either power, sample size, or enter the boundaries directly and solve for power and alpha.

When solving for power or sample size, the early-stopping boundaries are also calculated. High accuracy for
early-stopping boundaries requires a very large number of simulations (Recommended 100,000 to 10,000,000).

The parameter selected here is the parameter displayed on the vertical axis of the plot.

Because this is a simulation based procedure, the search for the sample size may take several minutes or hours to
complete. You may find it quicker and more informative to solve for Power for a range of sample sizes.

Test and Simulations

Test Type

Specify which test statistic is to be simulated and reported on.

For details and formulation of the tests, see the section in this manual above.
Higher Proportions Are

Use this option to specify the direction of the test.

If Higher Proportions are "Better”, the alternative hypothesis is H1: P1/P2 > RO.
If Higher Proportions are "Worse", the alternative hypothesis is H1: P1/P2 < RO.
Simulations

Specify the number of Monte Carlo iterations, M.

The following table gives an estimate of the precision that is achieved for various simulation sizes when the
power is near 0.50 and 0.95. The values in the table are the "Precision” amounts that are added and subtracted to
form a 95% confidence interval.

Simulation Precision Precision
Size when when

M Power = 0.50 Power =0.95

100 0.100 0.044
500 0.045 0.019
1000 0.032 0.014
2000 0.022 0.010
5000 0.014 0.006
10000 0.010 0.004
50000 0.004 0.002
100000 0.003 0.001
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However, when solving for power or sample size, the simulations are used to calculate the look boundaries. To
obtain precise boundary estimates, the number of simulations needs to be high. However, this consideration
competes with the length of time to complete the simulation. When solving for power, a large number of
simulations (100,000 or 1,000,000) will finish in several minutes. When solving for sample size, perhaps 10,000
simulations can be run for each iteration. Then, a final run with the resulting sample size solving for power can be
run with more simulations.

Power and Alpha

Power

Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1-Beta, so specifying
power implicitly specifies beta.

Beta is the probability obtaining a false negative on the statistical test. That is, it is the probability of accepting a
false null hypothesis.

In the context of simulated group sequential trials, the power is the proportion of the alternative hypothesis
simulations that cross any one of the significance (efficacy) boundaries.

The valid range is between 0 to 1.

Different disciplines and protocols have different standards for setting power. A common choice is 0.90, but 0.80
is also popular.

You can enter a range of values such as 0.70 0.80 0.90 or 0.70 to 0.90 by 0.1.
Alpha

Alpha is the probability of obtaining a false positive on the statistical test. That s, it is the probability of rejecting
a true null hypothesis.

The null hypothesis is usually that the parameters (the means, proportions, etc.) are all equal.

In the context of simulated group sequential trials, alpha is the proportion of the null hypothesis simulations that
cross any one of the significance (efficacy) boundaries.

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.250.
Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

e Equal (N1 =N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

e Enter N2, solve for N1

Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
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e Enter R =N2/N1, solve for N1 and N2

For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is

N2 =R * N1.

e Enter percentage in Group 1, solve for N1 and N2

For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option isdisplayed if Group Allocation = “Enter N2, solve for N1
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be > 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R =N2/N1.

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.

N2 is related to N1 by the formula:
N2 = [R x N1],
where the value [Y] is the next integer >Y.

For example, setting R =2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.

Percentin Group 1
This option isdisplayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Group Allocation

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are

e Equal (N1 =N2)

This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.
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e Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

e Enter N1 and R, where N2 =R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

e Enter total sample size and percentage in Group 1

Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option isdisplayed only if Group Allocation = “Equal (N1 = N2).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.

The Sample Size Per Group must be > 2. You can enter a single value or a series of values.

N1 (Sample Size, Group 1)

This option isdisplayed if Group Allocation = “Enter N1 and N2 individually’” or “Enter N1 and R, where N2 =
R*NL1.”

N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be > 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option isdisplayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be > 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option isdisplayed only if Group Allocation = ““Enter N1 and R, where N2 =R * N1.”
R is the ratio of N2 to N1. That is,

R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:

N2=[R x N1],

where the value [Y] is the next integer > Y.
For example, setting R =2.0 results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.

Total Sample Size (N)
This option isdisplayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
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The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.

You can enter a single value or a series of values.
Percentin Group 1
This option isdisplayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size — Ratios
RO (Ratio|HO = P1.0/P2)
Specify the superiority ratio of P1.0to P2.

When higher proportions are "Better", the superiority ratio is smallest ratio of P1 to P2 for which P1 will still be
considered superior. When higher proportions are "Better”, RO should be greater than one.

When higher proportions are "Worse", the superiority ratio is largest ratio of P1to P2 for which P1 will still be
considered superior. When higher proportions are "Worse", RO should be less than one.

The power calculations assume that P1.0 is the value of P1 under the null hypothesis. This value is used with P2
to calculate the value of P1.0using the formula: P1.0= R0 x P2

You may enter a range of values such as .95 .97 .99 or .91 t0 .99 by .02.
Ratios must be positive. RO cannot take on the value of one.

R1 (Ratio|H1 = P1.1/P2)

Specify the actual ratio between P1.1 (the actual value of P1) and P2. This is the value at which the power is
calculated.

When higher proportions are "Better”, R1 should be greater than RO.
When higher proportions are "Worse", R1 should be less than RO.

The power calculations assume that P1.1 is the actual value of the proportion in group 1 (experimental or
treatment group). This ratio is used with P2 to calculate the value of P1 using the formula: P1.1=R1 x P2

You may enter a range of values such as .951 1.05 or .9 to 1 by .02.

Ratios must be positive.

Effect Size — Group 2 (Reference)

P2 (Group 2 Proportion)

Enter a value for the proportion in the control (baseline, standard, or reference) group, P2.
When P2 is close to zero or one, a Zero Count Adjustment may be needed.

Values must be between 0 and 1.

You can enter a list of values such as 0.4 0.50.6 or 0.3to 0.7 by 0.05.
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Looks & Boundaries Tab when Solving for Power or Sample Size

The Looks & Boundaries tab contains settings for the looks and significance boundaries.

Looks and Boundaries

Specification of Looks and Boundaries

Choose whether spending functions will be used to divide alpha and beta for each look (Simple Specification), or
whether the percents of alpha and beta to be spent at each look will be specified directly (Custom Specification).

Under Simple Specification, the looks are automatically considered to be equally spaced. Under Custom
Specification, the looks may be equally spaced or custom defined based on the percent of accumulated
information.

Looks and Boundaries — Simple Specification

Number of Equally Spaced Looks
Select the total number of looks that will be used if the study is not stopped early for the crossing of a boundary.

Alpha Spending Function

Specify the type of alpha spending function to use.

The O'Brien-Fleming Analog spends very little alpha at the beginning and much more at the final looks. The
Pocock Analog and (Alpha)(Time) spending functions spend alpha more evenly across the looks. The Hwang-
Shih-DeCani (C) (sometimes called the gamma family) spending functions and (Alpha)(Time”~C) spending

functions are flexible spending functions that can be used to spend more alpha early or late or evenly, depending
on the choice of C.

C (Alpha Spending)
C is used to define the Hwang-Shih-DeCani (C) or (Alpha)(Time"C) spending functions.

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of alpha at later looks,
values near 0 spend alpha evenly, and positive values of C spend more of alpha at earlier looks.

For the (Alpha)(Time”~C) spending function, only positive values for C are permitted. Values of C near zero spend
more of alpha at earlier looks, values near 1 spend alpha evenly, and larger values of C spend more of alpha at
later looks.

Type of Futility Boundary

This option determines whether or not futility boundaries will be created, and if so, whether they are binding or
non-binding.

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Binding futility boundaries are computed in concert with significance boundaries. They are called binding

because they require the stopping of atrial if they are crossed. If the trial is not stopped, the probability of a false
positive will exceed alpha.

When non-binding futility boundaries are computed, the significance boundaries are first computed, ignoring the
futility boundaries. The futility boundaries are then computed. These futility boundaries are non-binding because
continuing the trial after they are crossed will not affect the overall probability of a false positive declaration.

Number of Skipped Futility Looks

In some trials it may be desirable to wait a number of looks before examining the trial for futility. This option
allows the beta to begin being spent after a specified number of looks.

The Number of Skipped Futility Looks should be less than the number of looks.
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Beta Spending Function
Specify the type of beta spending function to use.

The O'Brien-Fleming Analog spends very little beta at the beginning and much more at the final looks. The
Pocock Analog and (Beta)(Time) spending functions spend beta more evenly across the looks. The Hwang-Shih-
DeCani (C) (sometimes called the gamma family) spending functions and (Beta)(Time”C) spending functions are
flexible spending functions that can be used to spend more beta early or late or evenly, depending on the choice of
C.

C (Beta Spending)
C is used to define the Hwang-Shih-DeCani (C) or (Beta)(Time™C) spending functions.

For the Hwang-Shih-DeCani (C) spending function, negative values of C spend more of beta at later looks, values
near 0 spend beta evenly, and positive values of C spend more of beta at earlier looks.

For the (Beta)(Time"C) spending function, only positive values for C are permitted. Values of C near zero spend
more of beta at earlier looks, values near 1 spend beta evenly, and larger values of C spend more of beta at later
looks.

Looks and Boundaries — Custom Specification

Number of Looks
This is the total number of looks of either type (significance or futility or both).

Equally Spaced

If this box is checked, the Accumulated Information boxes are ignored and the accumulated information is evenly
spaced.

Type of Futility Boundary

This option determines whether or not futility boundaries will be created, and if so, whether they are binding or
non-binding.

Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Binding futility boundaries are computed in concert with significance boundaries. They are called binding

because they require the stopping of atrial if they are crossed. If the trial is not stopped, the probability of a false
positive will exceed alpha.

When Non-binding futility boundaries are computed, the significance boundaries are first computed, ignoring the
futility boundaries. The futility boundaries are then computed. These futility boundaries are non-binding because
continuing the trial after they are crossed will not affect the overall probability of a false positive declaration.

Accumulated Information

The accumulated information at each look defines the proportion or percent of the sample size that is used at that
look.

These values are accumulated information values so they must be increasing.

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes will be divided
by the value at the final look to create an accumulated information proportion for each look.

Percent of Alpha Spent
This is the percent of the total alpha that is spent at the corresponding look. It is not the cumulative value.

Percents, proportions, or alphas may be entered here. Each of the values is divided by the sum of the values to
obtain the proportion of alpha that is used at the corresponding look.
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Percent of Beta Spent
This is the percent of the total beta (1-power) that is spent at the corresponding look. It is not the cumulative
value.

Percents, proportions, or betas may be entered here. Each of the values is divided by the sum of the values to
obtain the proportion of beta that is used at the corresponding look.

Looks & Boundaries Tab when Solving for Alphaand Power

The Looks & Boundaries tab contains settings for the looks and significance boundaries.

Looks and Boundaries

Number of Looks
This is the total number of looks of either type (significance or futility or both).

Equally Spaced
If this box is checked, the Accumulated Information boxes are ignored and the accumulated information is evenly
spaced.

Types of Boundaries
This option determines whether or not futility boundaries will be entered.
Futility boundaries are boundaries such that, if crossed at a given look, stop the study in favor of HO.

Accumulated Information

The accumulated information at each look defines the proportion or percent of the sample size that is used at that
look.

These values are accumulated information values so they must be increasing.

Proportions, percents, or sample sizes may be entered. All proportions, percents, or sample sizes will be divided
by the value at the final look to create an accumulated information proportion for each look.

Significance Boundary

Enter the value of the significance boundary corresponding to the chosen test statistic. These are sometimes called
efficacy boundaries.

Futility Boundary
Enter the value of the futility boundary corresponding to the chosen test statistic.
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Options Tab

The Options tab contains limits on the number of iterations and various options about individual tests.

Maximum lterations

Maximum N1 Before Search Termination
Specify the maximum N1 before the search for N1 is aborted.

Since simulations for large sample sizes are very computationally intensive and hence time-consuming, this value
can be used to stop searches when N1 is larger than reasonable sample sizes for the study.

This applies only when "Solve For" is set to N1.

The procedure uses a binary search when searching for N1. If a value for N1 is tried that exceeds this value, and
the power is not reached, a warning message will be shown on the output indicating the desired power was not
reached.

We recommend a value of at least 20000.

Matching Boundaries at Final Look

Beta Search Increment
For each simulation, when futility bounds are computed, the appropriate beta is found by searching from 0 to 1 by
this increment. Smaller increments are more refined, but the search takes longer.

We recommend 0.001 or 0.0001.

Zero Count Adjustment

Zero Count Adjustment Method

Zero cell counts cause many calculation problems. To compensate for this, a small value (called the Zero Count
Adjustment Value) may be added either to all cells or to all cells with zero counts. This option specifies whether
you want to use the adjustment and which type of adjustment you want to use.

Adding asmall value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while
others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well.

Zero Count Adjustment Value
Zero cell counts cause many calculation problems. To compensate for this, a small value may be added either to
all cells or to all zero cells. This is the amount that is added.

Some statisticians recommend that the value of 0.5 be added to all cells (both zero and non-zero). Others
recommend 0.25. We have found that even a value as small as 0.0001 works well.
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Example 1 - Power and Output

A clinical trial is to be conducted over a two-year period to compare the proportion response of a new treatment to
that of the current treatment. The current response proportion is 0.58. The researchers would like to show that the
new treatment is at least 9% better than the standard treatment. This corresponds to a rate ratio of 1.09. Although
the researchers do not know the true proportion of patients that will survive with the new treatment, they would
like to examine the power that is achieved if the proportion under the new treatment is 0.68 (rate ratio of 1.1724).
The sample size at the final look is to be 1000 per group. Testing will be done at the 0.05 significance level. A
total of five tests are going to be performed on the data as they are obtained. The O’Brien-Fleming (Analog)
boundaries will be used. .

Find the power and test boundaries assuming equal sample sizes per arm.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Superiority by a Margin Tests for the Ratio of Two Proportions
(Simulation) procedure window by expanding Proportions, then Two Independent Proportions, then clicking
on Group-Sequential, and then clicking on the Group-Sequential Superiority by a Margin Tests for the Ratio
of Two Proportions (Simulation). You may then make the appropriate entries as listed below, or open Example
1 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOr i Power

TESt TYPE .ovvvieeiiie e Likelihood Score (Farr. & Mann.)
Higher Proportions Are.........ccccooeevevennnn. Better
SIMUIALIONS ... 100000

Alpha ..., 0.05

Group Allocation ..........ccoeeeeviiiieeriiinnnnn. Equal (N1=N2)
Sample Size Per Group.............cccvvvennne 1000

RO (Ratio]HO = P1.0/P2).........ccceevveennne. 1.09

R1 (Ratio]HL = P1.1/P2).....ccccuvvueiinaennn. 1.1724

P2 (Group 2 Proportion) .........ccccceeevenn... 0.58

Looks & Boundaries Tab
Specification of Looks and Boundaries ...Simple

Number of Equally Spaced Looks.......... 5
Alpha Spending Function....................... O'Brien-Fleming Analog
Type of Futility Boundary....................... None
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Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Ratio = RO.
Hypotheses: HO: Proportion 1 / Proportion 2 = RO; H1: Proportion 1/ Proportion 2 > R0
Test Statistic: Likelihood Score (Farrington and Manning) Test

Zero Adjustment Method: None

Alpha-Spending Function: O'Brien-Fleming Analog

Beta-Spending Function: None

Futility Boundary Type: None

Number of Looks: 5

Simulations: 100000

Numeric Summary for Scenario 1

—————————————————— Power ------------me oo B e Y o] o - R
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta
0.671 0.668 0.674 0.050 0.050 0.049 0.051 0.329
————— Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 RO R1 P1.0 P1.1 P2

1000 1000 992 992 840 840 1.09 1.17 0.63 0.68 0.58

Report Definitions

Power is the probability of rejecting a false null hypothesis at one of the looks. It is the total proportion
of alternative hypothesis simulations that are outside the significance boundaries.

Power 95% LCL and UCL are the lower and upper confidence limits for the power estimate. The width of the
interval is based on the number of simulations.

Target Alpha is the user-specified probability of rejecting a true null hypothesis. It is the total alpha
spent.

Alpha or Actual Alpha is the alpha level that was actually achieved by the experiment. It is the total
proportion of the null hypothesis simulations that are outside the significance boundaries.

Alpha 95% LCL and UCL are the lower and upper confidence limits for the actual alpha estimate. The width of
the intenal is based on the number of simulations.

Beta is the probability of accepting a false null hypothesis. It is the total proportion of alternative
hypothesis simulations that do not cross the significance boundaries.

N1 and N2 are the sample sizes of each group if the study reaches the final look.

Average Sample Size Given HO Grpl and Grp2 are the average or expected sample sizes of each group if HO is
true. These are based on the proportion of null hypothesis simulations that cross the significance or
futility boundaries at each look.

Average Sample Size Given H1 Grpl and Grp2 are the average or expected sample sizes of each group if H1 is
true. These are based on the proportion of alternative hypothesis simulations that cross the significance
or futility boundaries at each look.

RO, or superiority ratio, is the proportion ratio between groups (Grpl / Grp2) assuming the null hypothesis,
HO.

R1 is the proportion ratio between groups (Grpl / Grp2) assuming the alternative hypothesis, H1.

P1.0 is the proportion used in the simulations for Group 1 under HO.

P1.1 is the proportion used in the simulations for Group 1 under H1.

P2 is the proportion used in the simulations for Group 2 under HO and H1.

Summary Statements

Group sequential trials with sample sizes of 1000 and 1000 at the final look achieve 67% power
to detect a ratio of 1.17 of the treatment group proportion to a control group proportion of

0.58 with a superiority ratio of 1.09 at the 0.050 significance level (alpha) using a one-sided
Likelihood Score (Farrington and Manning) Test.
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Accumulated Information Details for Scenario 1

Accumulated

Information - Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
3 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000

Accumulated Information Details Definitions

Look is the number of the look.

Accumulated Information Percent is the percent of the sample size accumulated up to the corresponding look.

Accumulated Sample Size Group 1 is total number of individuals in group 1 at the corresponding look.

Accumulated Sample Size Group 2 is total number of individuals in group 2 at the corresponding look.

Accumulated Sample Size Total is total number of individuals in the study (group 1 + group 2) at the
corresponding look.

Boundaries for Scenario 1

-- Significance Boundary --

Z-Value P-Value
Look Scale Scale
1 3.95517 0.00004
2 2.90576 0.00183
3 2.30171 0.01068
4 1.95988 0.02500
5) 1.73454 0.04141

Boundaries Definitions
Look is the number of the look.
Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the
corresponding look indicate termination of the study and rejection of the null hypothesis. They are
sometimes called efficacy boundaries.
Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding
look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to
the Z-Value Boundary and is sometimes called the nominal alpha.

Boundary Plot
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Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1

--------- Z-Value Boundary ---------  ----—----- P-Value Boundary ---------
Look Value 95%LCL 95% UCL Value 95%LCL 95% UCL
1 3.95517 0.00004
2 2.90576 2.85765 2.97418 0.00183 0.00147  0.00213
3 2.30171 2.28150 2.32354 0.01068 0.01008  0.01126
4 1.95988 1.94567 1.97661 0.02500 0.02404  0.02585
5 1.73454 1.72395  1.74940 0.04141 0.04011 0.04236

Significance Boundary Confidence Limit Definitions

Look is the number of the look.

Z-Value Boundary Value is the value such that statistics outside this boundary at the corresponding look
indicate termination of the study and rejection of the null hypothesis. They are sometimes called efficacy

boundaries.

NCSS.com

P-Value Boundary Value is the value such that P-Values outside this boundary at the corresponding look

indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to the

Z-Value Boundary and is sometimes called the nominal alpha.
95% LCL and UCL are the lower and upper confidence limits for the boundary at the given look. The width of the

intenval is based on the number of simulations.
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Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

--------- Target ---------  -----—---- Actual ---------- Proportion Cum.

Cum. H1 Sims H1 Sims

--- Signif. Boundary--- Spending Spending Cum. Qutside Outside

Z-Value P-Value Function Function Alpha Alpha Signif. Signif.

Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary
1 3.95517 0.00004 0.000 0.000 0.000 0.000 0.001 0.001
2 2.90576 0.00183 0.002 0.002 0.002 0.002 0.056 0.057
3 2.30171 0.01068 0.009 0.011 0.009 0.011 0.199 0.256
4 1.95988 0.02500 0.017 0.028 0.017 0.028 0.231 0.486
5 1.73454 0.04141 0.022 0.050 0.022 0.050 0.184 0.671

Alpha-Spending Details Definitions

Look is the number of the look.

Significance Boundary Z-Value Scale is the value such that statistics outside this boundary at the
corresponding look indicate termination of the study and rejection of the null hypothesis. They are
sometimes called efficacy boundaries.

Significance Boundary P-Value Scale is the value such that P-Values outside this boundary at the corresponding
look indicate termination of the study and rejection of the null hypothesis. This P-Value corresponds to
the Significance Z-Value Boundary and is sometimes called the nominal alpha.

Spending Function Alpha is the intended portion of alpha allocated to the particular look based on the
alpha-spending function.

Cumulative Spending Function Alpha is the intended accumulated alpha allocated to the particular look. It is
the sum of the Spending Function Alpha up to the corresponding look.

Alpha Spent is the proportion of the null hypothesis simulations resulting in statistics outside the
Significance Boundary at this look.

Cumulative Alpha Spent is the proportion of the null hypothesis simulations resulting in Significance Boundary
termination up to and including this look. It is the sum of the Alpha Spent up to the corresponding look.

Proportion H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations
resulting in statistics outside the Significance Boundary at this look. It may be thought of as the
incremental power.

Cumulative H1 Sims Outside Significance Boundary is the proportion of the alternative hypothesis simulations
resulting in Significance Boundary termination up to and including this look. It is the sum of the
Proportion H1 Sims Outside Significance Boundary up to the corresponding look.

The values obtained from any given run of this example will vary slightly due to the variation in simulations.
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Example 2 — Power with Futility Boundaries

Continuing with Example 1, suppose that the researchers would also like to terminate the study early if there is
indication that the treatment is not better than the standard by 0.05.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Superiority by a Margin Tests for the Ratio of Two Proportions
(Simulation) procedure window by expanding Proportions, then Two Independent Proportions, then clicking
on Group-Sequential, and then clicking on the Group-Sequential Superiority by a Margin Tests for the Ratio
of Two Proportions (Simulation). You may then make the appropriate entries as listed below, or open Example
2 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOr i, Power

TeSt TYP ..vniiei e Likelihood Score (Farr. & Mann.)
Higher Proportions Are.........ccccooevvevennnn. Better
SIMUIAtIoNS ......cvvviiieeei e 100000

Alpha ..., 0.05

Group Allocation ...........coeveeveviiieeieiinnnnn. Equal (N1=N2)
Sample Size Per Group.............cccvvvennne 1000

RO (Ratio]HO = P1.0/P2).......c.cuvveieiaenen. 1.09

R1 (Ratio]HL = P1.1/P2).....ccccuvvuiirnnn. 1.1724

P2 (Group 2 Proportion) .........cc..ceeevenne.. 0.58

Looks & Boundaries Tab
Specification of Looks and Boundaries ...Simple

Number of Equally Spaced Looks.......... 5

Alpha Spending Function....................... O'Brien-Fleming Analog
Type of Futility Boundary....................... Non-Binding

Number of Skipped Fultility Looks........... 0

Beta Spending Function........................ O’Brien-Fleming Analog
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Ratio = RO.
Hypotheses: HO: Proportion 1 / Proportion 2 = RO; H1: Proportion 1/ Proportion 2 > R0
Test Statistic: Likelihood Score (Farrington and Manning) Test

Zero Adjustment Method: None

Alpha-Spending Function: O'Brien-Fleming Analog

Beta-Spending Function: O'Brien-Fleming Analog

Futility Boundary Type: Non-binding

Number of Looks: 5

Simulations: 100000
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Numeric Summary for Scenario 1

------------------ Power -------nmmeme oo B ey Y o] o R
Value 95% LCL 95% UCL Target Actual 95% LCL 95% UCL Beta
0.556 0.553 0.559 0.050 0.036 0.035 0.037 0.444
————— Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2  Grpl Grp2 Grpl Grp2 RO R1 P1.0 P1.1 P2

1000 1000 419 419 640 640 1.09 1.17 0.63 0.68 0.58

Accumulated Information Details for Scenario 1

Accumulated

Information - Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
3 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000

Boundaries for Scenario 1

-- Significance Boundary -- - Futility Boundary -----

Z-Value P-Value Z-Value P-Value

Look Scale Scale Scale Scale
1 3.85258 0.00006 -0.40348 0.65670
2 2.90290 0.00185 0.51756 0.30238
3 2.29873 0.01076 0.99732 0.15930
4 1.96529 0.02469 1.35899 0.08708
5 1.73663 0.04123 1.73663 0.04123

Boundary Plot
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Significance Boundaries with 95% Simulation Confidence Intervals for Scenario 1

--------- Z-Value Boundary ---------

- P-Value Boundary --------

Look Value 95% LCL 95% UCL Value 95% LCL 95% UCL
1 3.85258 0.00006

2 2.90290 2.85416  2.94761 0.00185 0.00160 0.00216
3 2.29873 2.27514  2.32010 0.01076 0.01017  0.01145
4 1.96529 1.94786  1.98296 0.02469 0.02369  0.02572
5 1.73663 1.72476  1.75093 0.04123 0.03998  0.04229

Futility Boundaries with 95% Simulation Confidence Intervals for Scenario 1

--------- Z-Value Boundary ---------

- P-Value Boundary --------

Look Value 95%LCL 95% UCL Value 95%LCL 95% UCL
1 -0.40348  -0.41358 -0.39349 0.65670

2 0.51756 0.50913  0.52583 0.30238 0.29950  0.30533
3 0.99732 0.98907  1.00558 0.15930 0.15731  0.16131
4 1.35899 1.34923 1.36417 0.08708 0.08626  0.08863
5 1.73663 1.73020 1.75120 0.04123 0.03996  0.04180

Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

————————— Target --------- - Actual ----—------ Proportion Cum.

Cum. HO Sims  HO Sims

--- Signif. Boundary--- Spending Spending Cum. Outside Outside

Z-Value P-Value Function Function Alpha Alpha Futility Futility

Look Scale Scale Alpha Alpha Spent Spent Boundary Boundary

1 3.85258 0.00006 0.000 0.000 0.000 0.000 0.345 0.345

2 2.90290 0.00185 0.002 0.002 0.002 0.002 0.371 0.716

3 2.29873 0.01076 0.009 0.011 0.009 0.011 0.153 0.869

4 1.96529 0.02469 0.017 0.028 0.014 0.026 0.067 0.936

5 1.73663 0.04123 0.022 0.050 0.010 0.036 0.028 0.964
Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1

--------- Target ---------  ---—----- Actual ---------- Proportion Cum.

Cum. H1 Sims  H1 Sims

- Futility Boundary-- Spending Spending Cum. QOutside Outside

Z-Value P-Value Function Function Beta Beta Signif. Signif.

Look Scale Scale Beta Beta Spent Spent Boundary Boundary

1 -0.40348 0.65670 0.088 0.088 0.087 0.087 0.002 0.002

2 0.51756 0.30238 0.140 0.228 0.140 0.227 0.057 0.059

3 0.99732 0.15930 0.097 0.325 0.097 0.324 0.195 0.254

4 1.35899 0.08708 0.069 0.394 0.069 0.393 0.202 0.456

5 1.73663 0.04123 0.052 0.446 0.051 0.444 0.100 0.556

The values obtained from any given run of this example will vary slightly due to the variation in simulations.

223-25
© NCSS, LLC. All Rights Reserved.


http://www.ncss.com/

PASS Sample Size Software NCSS.com
Group-Sequential Superiority by a Margin Tests for the Ratio of Two Proportions (Simulation)

Example 3 — Enter Boundaries

With a set-up similar to Example 2, suppose we wish to investigate the properties of a set of significance (3, 3, 3,
2, 1) and futility (-2, -1, 0, 0, 1) boundaries.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Superiority by a Margin Tests for the Ratio of Two Proportions
(Simulation) procedure window by expanding Proportions, then Two Independent Proportions, then clicking
on Group-Sequential, and then clicking on the Group-Sequential Superiority by a Margin Tests for the Ratio
of Two Proportions (Simulation). You may then make the appropriate entries as listed below, or open Example
3 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SoIVE FOI oo, Alpha and Power (Enter Boundaries)
TeSt TYP ..uiiei e Likelihood Score (Farr. & Mann.)
Higher Proportions Are...........cccccovvevennnn. Better

SIMUIAtIoNS .......vvviiiieei e 100000

Group Allocation ...........ccoeeeeviiineeiiiinnnnn. Equal (N1 =N2)

Sample Size Per Group.............ccovvvennne 1000

RO (Ratio]HO = P1.0/P2).........ccceeveeennne. 1.09

R1 (Ratio]HL = P1.1/P2)......cccuvvueienaennn. 1.1724

P2 (Group 2 Proportion) .........cc..cceuvenn... 0.58

Looks & Boundaries Tab

Number of LOOKS..........cooveiiiiviiiinineee, 5

Equally Spaced..........c.oevvviiiiiiiiniiiennnn, Checked

Types of Boundaries.........cccooeeevvinieenans Significance and Futility Boundaries
Significance Boundary................ccc.unn.... 33321 (for looks 1through 5)
Futility Boundary..........cccooeevvviinieiiinnnnnn. -2-100 1 (for looks 1 through 5)
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Scenario 1 Numeric Results for Group Sequential Testing Proportion Ratio = RO.
Hypotheses: HO: Proportion 1 / Proportion 2 = RO; H1: Proportion 1/ Proportion 2 > R0
Test Statistic: Likelihood Score (Farrington and Manning) Test

Zero Adjustment Method: None

Type of Boundaries: Significance and Futility Boundaries

Number of Looks: 5

Simulations: 100000
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Numeric Summary for Scenario 1

------------------ Power ------------m- - B ey Y o] o R
Value 95% LCL 95% UCL Value 95% LCL 95% UCL Beta
0.857 0.854 0.859 0.150 0.148 0.153 0.143
————— Average Sample Size ----
-- Given HO -- -- Given H1 --
N1 N2  Grpl Grp2 Grpl Grp2 RO R1 P1.0 P1.1 P2
1000 1000 738 738 845 845 1.09 1.17 0.63 0.68 0.58
Accumulated Information Details for Scenario 1
Accumulated
Information - Accumulated Sample Size --------
Look Percent Group 1 Group 2 Total
1 20.0 200 200 400
2 40.0 400 400 800
8 60.0 600 600 1200
4 80.0 800 800 1600
5 100.0 1000 1000 2000
Boundaries for Scenario 1
-- Significance Boundary -- - Futility Boundary -----
Z-Value P-Value Z-Value P-Value
Look Scale Scale Scale Scale
1 3.00000 0.00135 -2.00000 0.97725
2 3.00000 0.00135 -1.00000 0.84134
8 3.00000 0.00135 0.00000 0.50000
4 2.00000 0.02275 0.00000 0.50000
5 1.00000 0.15866 1.00000 0.15866
Boundary Plot
3 Boundary Flot
24
3 1
o
= ) Boundary Type
% @ Sig. Boundary
e /,/ @ Fut. Boundary
g o e
////
14 .’
e
-2 O- T T T |
1 2 3 4 5
Look
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Boundary Plot - P-Value

P-Value

1.0 4
C

0.8

0.6 -

0.4 -

0.2 ~

0.0

Boundary Plot

Boundary Type
@ Sig. Boundary
@ Fut. Boundary

N @

Look

Alpha-Spending and Null Hypothesis Simulation Details for Scenario 1

Z-Value

Scale
3.00000
3.00000
3.00000
2.00000
1.00000

--- Signif. Boundary---

P-Value Alpha

Scale Spent
0.00135 0.001
0.00135 0.001
0.00135 0.001
0.02275 0.021
0.15866 0.126

Proportion
HO Sims
Outside
Futility
Boundary B
0.023
0.141
0.343
0.081
0.262

Cum.
HO Sims
Outside

Futility
oundary

0.023

0.163

0.506

0.587

0.850

Beta-Spending and Alternative Hypothesis Simulation Details for Scenario 1

-- Futility Boundary--

Z-Value
Scale
-2.00000
-1.00000
0.00000
0.00000
1.00000

P-Value Beta

Scale Spent
0.97725 0.002
0.84134 0.009
0.50000 0.041
0.50000 0.008
0.15866 0.083

Proportion
H1 Sims
Outside
Signif.
Boundary B
0.021
0.038
0.051
0.352
0.395

Cum.
H1 Sims
Outside

Signif.
oundary

0.021

0.058

0.110

0.461

0.857

NCSS.com

The values obtained from any given run of this example will vary slightly due to the variation in simulations.
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Example 4 — Validation using Simulation

With a set-up similar to Example 2, we examine the power and alpha generated by the set of significance
(3.85258, 2.90290, 2.29873, 1.96529, 1.73663) and futility (-0.40348, 0.51756, 0.99732, 1.35899, 1.73663)
boundaries.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Group-Sequential Superiority by a Margin Tests for the Ratio of Two Proportions
(Simulation) procedure window by expanding Proportions, then Two Independent Proportions, then clicking
on Group-Sequential, and then clicking on the Group-Sequential Superiority by a Margin Tests for the Ratio
of Two Proportions (Simulation). You may then make the appropriate entries as listed below, or open Example
4 by going to the File menu and choosing Open Example Template.

Option Value

Design Tab

SOIVE FOF oo Alpha and Power (Enter Boundaries)

TESt TYPE .ovvvieiiiii e Likelihood Score (Farr. & Mann.)

Higher Proportions Are..........cccceeevvvenn... Better

SIMUIALIONS ... 100000

Group Allocation ...........coeveeveviieeiiiinnnnn. Equal (N1=N2)

Sample Size Per Group........cccoeeevvvvnnnn.. 1000

RO (Ratio]HO = P1.0/P2).......c.cevueieraennn. 1.09

R1 (RatiojJHL = P1.1/P2).......cccvveieeennnn. 1.1724

P2 (Group 2 Proportion) .........cc..ceeevenn... 0.58

Looks & Boundaries Tab

Number of LOOKS............ooveiviiiiiiiiiinnnnn. 5

Equally Spaced...........ccooeveiviiiiiiiiiinnnnn, Checked

Types of Boundaries...........ccooceevvieennas Significance and Futility Boundaries
Significance Boundary................cccuunnne.. 3.85258, 2.90290, 2.29873, 1.96529, 1.73663
Futility Boundary.............coovvvvviiinnnnennnn. -0.40348, 0.51756, 0.99732, 1.35899, 1.73663
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots

Numeric Summary for Scenario 1

—————————————————— POWET =-mrmmemmcmccne oo AIPR@ oo oo
Value 95% LCL 95% UCL Value 95% LCL 95% UCL Beta
0.554 0.551 0.557 0.037 0.035 0.038 0.446

————— Average Sample Size ----

-- Given HO -- -- Given H1 --
N1 N2 Grpl Grp2 Grpl Grp2 RO R1 P1.0 P1.1 P2
1000 1000 420 420 637 637 1.09 1.17 0.63 0.68 0.58

The values obtained from any given run of this example will vary slightly due to the variation in simulations. The
power and alpha generated with these boundaries are very close to the values of Example 2.
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